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Legal Disclaimer

A\ Caution

This document contains sample configuration content. Unless expressly stated otherwise in your
agreements with SAP, this sample content is not part of SAP product documentation and you may not infer
any product documentation claims against SAP based on this information.

Configuration Guide for International Inbound Logistics
Legal Disclaimer PUBLIC



1

Configuration Guide for International

Inbound Logistics

This document contains the configuration settings for the International Inbound Logistics scenario. You must
implement this scenario as described and once you have verified the functionality, you can modify the data to

suit your own environment and operating conditions.

Change History

Version

Date

Description

1.0

December 2010

Initial version

11

April 2011

Harmonized configuration and master
data; scenarios based on IDES

1.2

November 2011

Update to Creating Dangerous Goods
Master Data [page 31]

2.0

September 2012

® The Defining Schedule Types [page
40] section has been added.

® Defining Means of Transport [page
37] and Defining Schedules [page
41] have been updated as part of
the SAP TM 9.0 setup:

® The Defining Departure Calendar
section has been removed.

3.0

December 2013

Updated for SAP Transportation Man-
agement 9.1

6
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Version Date Description
4.0 December 2014 Updated for SAP Transportation Man-
agement 9.2

The following chapters have been
moved to the Basic Settings for SAP
Transportation Management:

e Configuring EH&S Basic Services

e Specifying Validity Area Categories

e Specifying Validity Areas

e Specifying Dangerous Goods Reg-
ulations

e Specifying Dangerous Goods
Classes

The following chapters have been re-
moved:

e Activating EH&S Business Func-
tions

Important SAP Notes

You must read the following SAP Notes before you start using this test scenario. These SAP Notes contain the
most recent corrections required to test the scenario.

Make sure that you have the current version of each SAP Note, which you can find on SAP Service Marketplace
at http://service.sap.com/notes#ir.

SAP Note Number Description

1738013¥%r TM: Integration with ERP Enhancement Packages

Configuration Guide for International Inbound Logistics
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2 The Scenario

Use

Some settings in this guide can be copied from the existing SAP ERP configuration. In particular, SAP ERP
Customizing settings can be reused for the following:

® FEnterprise structure definition and relevant assignments
® Financial Accounting
e Controlling

If you require a scenario-specific enterprise structure, we recommend that you copy the existing, standard
configuration settings (such as Country Template for Company Codes incl. G/L Accounts) and change them as
necessary (such as addresses).

i Note

Business system groups, logical systems, RFC connections, and system connections used throughout this
guide are examples only. Replace these with your own data.

This guide also assumes the use of Business Add-Ins (BAdIs), which add a prefix or suffix to master data
objects transferred from SAP ERP to SAP TM (see SAP Note 458914 #% ). An overview of the prefixes and
suffixes used is provided in the table below:

Business Object Prefix Suffix
Carrier CA- None
Customer CU- None
Plant PL- None
Shipping Point SP- None
Supplier SU- None
System None —-@ERPOO1
Example:

Shipping point name in SAP ERP: 1200
Shipping point name in SAP TM: SP1200@ERPO001

If you have not implemented the corresponding BAdI in your system, the names of the objects will not be
changed.

Configuration Guide for International Inbound Logistics
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Prerequisites

Before you begin to configure the International Inbound Logistics scenario, you must have configured the
following guides in SAP Solution Manager under |[» SAP Transportation Management » Configuration Structures
Basic Settings for SAP TM 9.1

® Basic Settings and Integration for ERP

e Basic Settings for SAP TM

® Integration of SAP TM and SAP Event Management
e |ntegration of Output Management

e Basic Settings for Visual Business

Your SAP ERP system must also be configured to run the following processes:

e MM: Purchase-to-pay
o Purchase order entry
o Inbound delivery creation
o Posting goods receipt
o Logistics invoice verification
o Invoice document creation (ERS settlement)
o Transfer to accounting
e FI/CO
o Supporting the processes listed above
o Country-specific legal requirements (such as tax calculation)

If you want to integrate SAP TM with SAP EHS Dangerous Goods Management, you must configure your SAP
ERP system to run this process:
e EHS-DGP

o Dangerous goods master

o Dangerous goods checks

o Dangerous goods documents

User Profile

Before you begin to configure the International Inbound Logistics scenario, you must configure user profile
TM INVOICE_ CLERK inyour SAP ERP system. To do so, proceed as follows:

1. In SAP ERP, choose [|» System » User Profile » Own Data
2. Choose the Parameters tab page.

3. Inthe Parameter ID column, enter TM_INVOICE_CLERK.
4. Save your entries.

Geography

The International Inbound Logistics scenario assumes an international overseas transportation network with
two vendors located in China, ocean transport from the port in Shanghai to Hamburg, and a receiving/ordering
plant located in Dresden, Germany.

Configuration Guide for International Inbound Logistics
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Pre-Carriage Main Carriage On-Carriage

h IL-CR-03

IL-WR-01 (Carrier)
“’e”""” . B W
IL-CR-01 IIL CR-02
IL-CNSHA {Ocean Carrier) IL-DEHAM {Rail Carrier) PL-1200
| ILcroz (Port Shanghai) (Port Hamburg) (Consignee)

IL-N-02 (Carrier)
{Wendor)

Three Stages of the International Inbound Logistics Scenario

To use the transportation network as described in this document, you must ensure that the vendors and plant
used in the customer system are located in the same vicinity.

The following organizational structures and document types are used by default, and you must change these to
customer-specific organizational structures as required:

Company code 1000
Controlling area 1000
Plant 1200
Storage location 0001
Shipping point/receiving point 1200
Purchasing organization 1000
Sales organization 1000
Distribution channel 10
Purchase order document type L4

Configuration Guide for International Inbound Logistics
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3 Defining Organizational Setup in ERP

The following IDES data is used throughout this document:

e Controlling area 1000
e Company code 1000

You can also define your own organizational structure as required.

Defining Organizational Setup comprises the following processes:

e Assigning Goods Receiving Points for Inbound Deliveries [page 11]
e Defining Material Type Attributes [page 12]

3.1 Assignhing Goods Receiving Points for Inbound
Deliveries

Context

In this Customizing activity, you assign goods receiving points to the combination of plant and storage location.

Procedure

1. In Customizing for SAP ERP, choose ||¢ Logistics Execution » Shipping » Basic Shipping Functions

Shipping Point and Goods Receiving Point Determination » Assign Goods Receiving Points for Inbound

Deliveries

2. Create an entry with the following data:

Plant Storage Location Shipping Point

1200 0001 1200

Configuration Guide for International Inbound Logistics
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3.2 Defining Material Type Attributes

Context

In this Customizing activity, you define the attributes for material type HALB.

Procedure

1. In Customizing for SAP ERP, choose ||» Logistics — General » Material Master » Basic Settings » Material
Types » Define Attributes of Material Types

2. For material type HALB, create the following entry:

Val. Area Matl Type Qty Updating Value Updating

1200 HALB X X

3.3 Mapping Organizational Units for Purchasing

Context

In this Customizing activity, you define how organizational units for purchasing in SAP TM are mapped to those
in SAP ERP. You also configure additional settings for creating service purchase orders from freight settlement
documents.

Procedure

1. In Customizing for SAP ERP, choose ||» Integration with Other SAP Components » Transportation
Management » Invoice Integration ¥ Invoicing » Mapping of Organizational Units » Assign Organizational
Units for Purchasing

2. Choose New Entries.

Configuration Guide for International Inbound Logistics
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3. Add the following entry:

Field

Value

Logical System

Logical system ID for your SAP TM system, for example,
TMICLNTOO1

TM Pur. Organization

Enter the internal number of the purchasing organization
that you created in Creating Organizational Data in TM
[page 55]

TM Purchasing Group Enter the internal number of the purchasing group that
you created in Creating Organizational Data in TM [page
55]

Settlement Type IILS5

Purchasing Org. 1000

Purch. Group 002

Plant 1200

Company Code 1000

Document Type IIL4

Material Group 007

4. Save your entries.

Configuration Guide for International Inbound Logistics
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4 Defining Master Data in ERP: Material
and Vendor

e Defining Vendor Master Data [page 14]

e Defining Material Master Data [page 16]

4.1 Defining Vendor Master Data

Context

In this procedure, you create vendor master data. The vendor master is then transferred to SAP TM via CIF. The
corresponding locations with location type 1011 (Vendor) are created in SAP TM.

Procedure

1. Onthe SAP Easy Access screen for SAP ERP, choose
Master Data

Central » Create

Logistics

Materials Management j» Purchasing

2. Create the vendors assigned to the purchasing organization 1000 according to the tables below:

Vendor ID Company Code Purch. Organization Account Group
[IL-VN-01 1000 1000 0001
[IL-VN-02 1000 1000 0001
[IL-CR-01 1000 1000 0005
[IL-CR-02 1000 1000 0005
[IL-CR-03 1000 1000 0005
[IL-CR-04 1000 1000 0005
Configuration Guide for International Inbound Logistics
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On the Create Vendor: Address enter the following address data for each vendor:

Vendor ID Name Search Term Address

IIL-VN-01 [IL Vendor 1 IIL VENDOR 4711 Main Street
100621 Beijing
CN

IIL-VN-02 |IL Vendor 2 IIL VENDOR 7589 Main Street
518128 Shenzhen
CN

[IL-CR-01 Ocean Carrier Ocean Carrier Musterstrasse 5570
60326 Frankfurt am Main
DE

IIL-CR-02 DE Rail Carrier DE Rail Carrier Musterstrasse 1000
20095 Hamburg
DE

|IL-CR-03 CN Truck Carrier CN Truck Carrier CN

[IL-CR-04 CN Forwarding Agent CN Forwarding Agent CN

On the Create Vendor: Accounting Information Accounting screen, enter the following data for each vendor:

Vendor ID Recon. Account Cash Mgmnt Group
[IL-VN-01 160000 Al
[IL-VN-02 160000 Al
[IL-CR-01 160000 Al
[IL-CR-02 160000 Al
[IL-CR-03 160000 Al
[IL-CR-04 160000 Al

On the Create Vendor: Payment Transactions Accounting screen, enter the following data for each vendor:

Vendor ID

Payment Terms

[IL-VN-01

Blank

Configuration Guide for International Inbound Logistics
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Vendor ID Payment Terms
[IL-VN-02 Blank
[IL-CR-01 0002
[IL-CR-02 0002
[IL-CR-03 0002
[IL-CR-04 0002

On the Create Vendor: Purchasing Data screen, enter the following data for each vendor:

Field lIL-VN-01 1IL-VN-02 IIL-CR-01 IIL-CR-02 IIL-CR-03 IIL-CR-04
Order Crcy EUR EUR EUR EUR EUR EUR
Terms of 0001 0001 0002 0002 0002 0002
Payment
Incoterms FOB / Shang- FOB/Shang- Blank Blank Blank Blank
hai (IIL- hai (IIL-
CNSHA) CNSHA)
Purch. Group 002 002 Blank Blank Blank Blank
Pind Dely Time 32 days 32 days Blank Blank Blank Blank
Conf. Ctrl 0004 0004 Blank Blank Blank Blank
Shpg Cond. 01 01 Blank Blank Blank Blank
4.2 Defining Material Master Data
1. Onthe SAP Easy Access screen for SAP ERP, choose |» Logistics » Materials Management j» Material

Master

Material

Create (Special) » Semifinished Product

2. Create the material master for your semifinished product according to the tables below:

16

Material Industry Sector
[IL-PROD-01 C Chemical Industry
[IL-PROD-02 C Chemical Industry
Configuration Guide for International Inbound Logistics
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Material Industry Sector
|IL-PROD-03 C Chemical Industry
IIL-PROD-04 C Chemical Industry

3. Choose Select View(s) and select the following views:
o BasicDatal
o Basic Data 2
o Sales: General/Plant Data
o Purchasing
o Accounting 1
4. Inthe Organizational Levels dialog box, enter the following data:
o Plant: 1200
o Sales Org.:1000
o Distr. Channel: 10

5. Enter the data as shown in the following tables:
On the Basic Data I tab page:

Material ID Description Base Unit of Material Group Gross Weight Volume
Measure
|IL-PROD-01 Polymer Bulk (Int.  TO 01 1000 kg 1M3

Inbound Logistic)

[IL-PROD-02 DG Polymer Bulk  TO 01 1000 kg 1M3
(Int. Inbound Lo-
gistic)

[IL-PROD-03 DG Fertilizer Lig-  TO 01 1000 kg 1M3
uid (Int. Inbound

Log.)

[IL-PROD-04 DG Fertilizer Bulk ~ TO 01 1000 kg 1M3
(Int. Inbound
Log.)

On the Basic Data 2 tab page:

Material ID DG Indicator Profile
[IL-PROD-01 Blank

[IL-PROD-02 GPP

[IL-PROD-03 GPP

Configuration Guide for International Inbound Logistics
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Material ID DG Indicator Profile

[IL-PROD-04 GPP

On the Sales: General/Plant tab page:

Plant/Sales Org./
Material ID Distr. Channel Availability Check Transport Group LoadingGrp
[IL-PROD-01 1200/none/none KP (no check) 0001 (bulk) 0001 (Crane)
|IL-PROD-02 1200/none/none KP (no check) 0001 (bulk) 0001 (Crane)
|IL-PROD-03 1200/none/none KP (no check) 0002 (liquid) 0001 (Crane)
|IL-PROD-04 1200/none/none KP (no check) 0001 (bulk) 0001 (Crane)

On the Purchasing tab page:

Material Freight Grp (Op-

Material ID Purchasing Group Material Group tional)
[IL-PROD-01 002 01 2821
[IL-PROD-02 002 01 2821
[IL-PROD-03 002 01 1475
[IL-PROD-04 002 01 1475
On the Accounting 1 tab page:

Material ID Valuation Class Standard Price
[IL-PROD-01 7900 1000
[IL-PROD-02 7900 1100
[IL-PROD-03 7900 1200
[IL-PROD-04 7900 1300

i Note

I

1.

you want to use material freight groups, you must create them as follows:

In Customizing for SAP ERP, choose |f+ Logistics Execution » Transportation

Functions » Maintain Freight Code Sets and Freight Codes

2. Choose Define Material Freight Groups.

3. Enter a material freight group and a description.

Basic Transportation

Configuration Guide for International Inbound Logistics
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A Caution

The material master and vendor master must be transferred to SAP TM via CIF. This process is not
included in the scope of this document.

Configuration Guide for International Inbound Logistics
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5 Setting Up Customizing for Purchase
Document Transfer in ERP

e Defining Purchase Order Types [page 20]
e Activating Transfer of Purchase Orders [page 20]

5.1 Defining Purchase Order Types

Procedure

1. In Customizing for SAP ERP, choose ||» Materials Management » Purchasing j» Purchase Order #» Define
Document Types

2. Copy type NB to a new order type 1114 and enter the description Internat. Purchasing.

5.2 Activating Transfer of Purchase Orders

Use

In this Customizing activity, you activate the transfer of purchase orders to SAP TM.

Procedure
1. In Customizing for SAP ERP, choose ||¢ Integration with Other SAP Components j# Transportation

Management » Order Integration » Activate Transfer of Purchase Orders

Configuration Guide for International Inbound Logistics
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2. Assign control key 0006 to purchasing organization 1000, purchasing group 002, and purchase order type

[IL4:

Field Value

POrg 1000

PGr 002

OTyp IIL4

Ctrl Key 0006

TM No. BO50
Control Key Description As required

i Note

In the Pl settings, you must use technical transportation management number (TM No.) BO50 to connect
to the SAP TM system.

Configuration Guide for International Inbound Logistics
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6 Setting Up Dangerous Goods

e Defining Dangerous Goods Profiles [page 22]
e Configuring Phrase Management [page 23]
o Specifying Number Ranges for Phrases [page 23]
o Specifying Phrase Libraries and Phrase Groups [page 24]
o Editing Dangerous Goods Phrases [page 25]
o Editing Phrase Sets [page 25]
o Activating Phrase Assignments [page 26]
o Editing Phrase Set-Attribute Assignments [page 26]

6.1 Defining Dangerous Goods Profiles

Context

In this Customizing activity, you define profiles for processing dangerous goods. The Only Errors Read and All
Messages Read profiles are provided. You define general conditions for processing dangerous goods, for
example, by specifying which messages are allowed to process certain dangerous goods or whether you are
permitted to define dangerous goods manually.

You assign the profile when you define business object types for freight units or freight orders.

You can also specify the default modes of transport that have to be used for the dangerous goods check in case
the information is not available in the business document.

Procedure

1. In Customizing for SAP TM, choose || Basic Functions j» Dangerous Goods » Define Dangerous Goods
Profile
2. Enter the following data:

Field Value

DG Profile IIL_DG_PR1

Configuration Guide for International Inbound Logistics
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Field Value

Short Desc. Dangerous Goods Profile - Int. Inbound
L

DG Check Active Selected

DG Ind. Ctrl 1 - Manual Entry Not Allowed

Message Level 1 - All Messages

Default TrM 03 (Sea)

Default TrM Pre-Carr 01 (Road)

Default TrM On-Carr 02 (Rail)

3. Save your entries.

6.2 Configuring Phrase Management

e Specifying Number Ranges for Phrases [page 23]

e Specifying Phrase Libraries and Phrase Groups [page 24]
e Editing Dangerous Goods Phrases [page 25]

e FEditing Phrase Sets [page 25]

e Activating Phrase Assignments [page 26]

e FEditing Phrase Set-Attribute Assignments [page 26]

6.2.1 Specifying Number Ranges for Phrases

Context

In this Customizing activity, you define number ranges for phrase keys. Each phrase is uniquely identified by a
phrase key within one client.

Configuration Guide for International Inbound Logistics
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Procedure

1. In Customizing for SAP TM, choose |[» SCM Basis » EH&S Services » Phrase Management » Specify
Number Ranges for Phrases

2. Enter the following data:

No. From Number To Number Ext

OE 000000000000001 500000000000000 X

3. Save your entries.

6.2.2 Specifying Phrase Libraries and Phrase Groups

Context
In this Customizing activity, you define an active phrase library. Make sure that the active phrase library is cusT

(customer phrase library).

Procedure

1. In Customizing for SAP TM, choose |» SCM Basis » EH&S Services » Phrase Management » Specify
Phrase Libraries and Phrase Groups

2. Check that the active phrase library is cusT:

PhrLib Description for Phrase Library Active Library

CUST Customer Phrase Library X

Configuration Guide for International Inbound Logistics
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6.2.3 Editing Dangerous Goods Phrases

Procedure

1. In SAP NetWeaver Business Client, choose
Management » Edit Phrases

2. Enter the following data:

Master Data » Dangerous Goods Management » Phrase

Phrase
Library-No. Phrase Group Language key Phrase Text
CUST-000000000000001 DG-TEXT EN Dangerous Goods Phrase

CUST-400000000000000 DG-TEXT

EN

Dangerous Goods Phrase
with Long text

6.2.4 Editing Phrase Sets

Procedure

1. Onthe SAP NetWeaver Business Client, choose |» Master Data

Management ¥ Edit Phrase Sets
2. Enter the following data:

Phrase Set Language Key

Dangerous Goods Management » Phrase

Phrase Set Name

IIL_PHRASE_SET1 EN

Phrase Set — Int. Inbound Logistics

3. Assign phrases CUST-000000000000001 and CUST-400000000000000 to the phrase set.

Configuration Guide for International Inbound Logistics
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6.2.5 Activating Phrase Assighments

Procedure

1. In Customizing for SAP TM, choose |» SCM Basis » EH&S Services » Dangerous Goods Management
Dangerous Goods Master » Activate Phrase Assignment

2. Select Attribute Activation and choose Execute.

6.2.6 Editing Phrase Set-Attribute Assighments

Procedure

1. Onthe SAP NetWeaver Business Client, choose ||» Master Data » Dangerous Goods Management » Phrase
Management » Edit Phrase Set-Attribute Assignment

2. Choose DGTMD (DG: Dangerous Goods Master).

3. Assignphrase set IIL PHRASE SET1 to field hame PDGNUD.

4. Save your entries.
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7 Transferring Master Data from SAP ERP
to SAPTM

Procedure

1. Onthe SAP Easy Access screen for SAP ERP, choose |» Logistics # Central Functions ¥ Supply Chain

Planning Interface » Core Interface Advanced Planner and Optimizer ¥ Integration Model ¥ Create . or
enter transaction cFM1 in the command field.
2. Create separate integration models for transferring materials, plant, vendor, and shipping point and take
the following information into account:
o [IL-IM-MAT (<logical TM system name>) for material and plant
o [IL-IM-DAT (<logical TM system name>) for vendor and shipping point
o Use the following details for both models:
o Use the same logical TM system name
o Use APO application TM
o Prefix your material selection with the initial letters of the material and vendors: IIL*. Make sure that
only material and plant are highlighted for model IIL-IM-MAT and that only shipping point and vendor
are highlighted for model IIL-IM-DAT.
o Inmodel lIL-IM-DAT, make sure that you activate the creation of business partners in the Vendors
section by entering 2 (create both) in the Create Loc/BP field.

o Execute and save the models.

3. Onthe SAP Easy Access screen for SAP ERP, choose ||¢ Logistics j# Central Functions » Supply Chain

Planning Interface ¥ Core Interface Advanced Planner and Optimizer ¥ Integration Model » Activate i or
enter transaction cFM2 in the command field.

4. Activate the two data models, and use transaction sMQ1 to verify that all data is transported. Use
transaction sMQ2 in TM system to verify that data transfer completed successfully.

i Note

When you transfer vendors to the SAP TM system, you must ensure that the Create Loc./BP function
(create BPs in TM for location) is set to 2 on the Vendors tab page so that business partners are
generated for vendors.

i Note

You can also create business partners for plants and shipping conditions automatically by
implementing a BAdI. For more information, see SAP Note 1410353 ¥ .

i Note

If the same master data is present in more than one model, only one of the models must be activated
at a time. Otherwise, data is not transferred properly.

Checking/Updating Data Transported to SAP TM
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1.

In SAP NetWeaver Business Client, choose
Location

2. Verify the plant, receiving point, and vendors:

Master Data

Transportation Network » Locations # Define

ERP Data TM Data
Plant 1200 PL1200@ERPOO1
Receiving Point 1200 SP1200@ERPOO1

Vendor IIL-VN-01

SUIIL-VN-O1@ERPOOI

Vendor lIL-VN-02

SUIIL-VN-02@ERPO01

Carrier lIL-CR-01

CAIIL-CR-01@ERPOO1

Carrier lIL-CR-02

CAIIL-CR-02@ERPO01

3. Maintain the geocoordinates for the locations as follows:

4.

Location Longitude Latitude
PL1200@ERPOOI 7 50
SP1200@ERPOO1 7 50
SUIIL-VN-O1@ERPOO1 116 39
SUIIL-VN-02@ERPO01 114 22

In SAP NetWeaver Business Client, choose |j* Master Data

Goods Master » Create Dangerous Goods Master

5. Verify the following materials:

28

Dangerous Goods Management

Dangerous

ERP Data TM Data

[IL-PROD-03 [IL-PROD-03@ERPO01

[IL-PROD-02 [IL-PROD-02@ERPO01

[IL-PROD-01 [IL-PROD-01@ERPOO1

[IL-PROD-04 [IL-PROD-04@ERPOO1
i Note

Remember to replace the suffix @ERP001 with your own to check that the master data has been

created correctly.

PUBLIC

Configuration Guide for International Inbound Logistics
Transferring Master Data from SAP ERP to SAP TM



6. Onthe SAP Easy Access screen for SAP Transportation Management, choose ||¢ Transportation
Management » Master Data » Maintain Business Partner
7. Verify that the following carriers have the business partner role Vendor (BBP000):
0 IIL-CR-01
0 IIL-CR-02
0 IIL-CR-03
0 IIL-CR-04
© IIL-VN-01
0 IIL-VN-02

i Note

To add a new business partner role, select the relevant role from the Display in BP role dropdown box
and then save your changes.

More Information

e Defining Business Partners for Plants and Shipping Points [page 29]
e Assigning Business Partners to Plants [page 30]
e C(Creating Dangerous Goods Master Data [page 31]

71 Defining Business Partners for Plants and Shipping
Points

Context

i Note

If you have not implemented the BAdI for automatically creating business partners, you must create the
business partners manually. For more information about creating business partners automatically, see SAP
Note 1410353 .

Procedure

1. In SAP NetWeaver Business Client, choose ||+ Master Data » General * Define Business Partner
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2. Create a business partner of type Organization using the following data:
© BP Number: PL.-1200
o Country: DE
o BP Role: 000000 Business Partner (Gen.)

3. Save your entries.

4. Create a business partner of type Organization using the following data:
o BP Number: sSP-1200
o Country: DE

o BP Role: 000000 Business Partner (Gen.)
BP Role: CRMOOQOZ Ship-to Party

5. Create a business partner of type Organization using the following data:
o BP Number: IIL-VN-01
o Country: CN

o BP Role: 000000 Business Partner (Gen.)
BP Role: CRMOOQOZ Ship-to Party
BP Role: FSOOO0O Financial Services BP

7.2 Assigning Business Partners to Plants and Shipping
Points

Procedure

1. In SAP NetWeaver Business Client, choose |[» Master Data » Transportation Network # Locations # Define
Location
2. Editlocation PL1200@ERPOOL.

Location BP Number
PL1200@ERPOOLI. PL-1200
SP1200@ERPOO1 SP-1200

3. Onthe General tab page, enter PL-1200 in the BP Number field.
4. Assign business partner SP-1200 in the same way to location SP1200@ERPOO].

Configuration Guide for International Inbound Logistics
30 PUBLIC Transferring Master Data from SAP ERP to SAP TM



7.3 Creating Dangerous Goods Master Data

Procedure

1. In SAP NetWeaver Business Client, choose |¥ Master Data » Dangerous Goods Management » Dangerous
Goods Master » Create Dangerous Goods Master

2. Enter the following data:

Product DG Regulation Ty. ID No.
[IL-PROD-03@ERPOO1 ADR UN 1456
[IL-PROD-03@ERPOO1 IMDG UN 1456
[IL-PROD-03@ERPOO1 RID UN 1456
[IL-PROD-03@ERPOO1 CN UN 1456
[IL-PROD-02@ERPOOQ1 ADR UN 1456
[IL-PROD-02@ERPOOQ1 IMDG UN 1456
[IL-PROD-02@ERPO01 RID UN 1456
[IL-PROD-02@ERPO01 CN UN 1456
[IL-PROD-04@ERPOO1 ADR UN 1456
[IL-PROD-04@ERPOOQ1 IMDG UN 1456
[IL-PROD-04@ERPOOQ1 RID UN 1456
[IL-PROD-04@ERPOOQ1 CN UN 1456

3. Choose Detail Views.

4. Enter the following data on the Classification tab page:

Product Regulation Description Class Processing Status
[IL- ADR CUST-00000000000 3 10 (Released)
PROD-03@ERPO01 0001

[IL- IMDG CUST-00000000000 3 10 (Released)
PROD-03@ERPO0! 0001
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Product Regulation Description Class Processing Status
[IL- RID CUST-00000000000 3 10 (Released)
PROD-03@ERPOO1 0001

lL- CN CUST-00000000000 3 10 (Released)
PROD-03@ERPOO1 0001

[IL- ADR CUST-40000000000 5.2 10 (Released)
PROD-02@ERPOO1 0000

[IL- IMDG CUST-40000000000 5.2 10 (Released)
PROD-02@ERPOO1 0000

[IL- RID CUST-40000000000 5.2 10 (Released)
PROD-02@ERPOO1 0000

[IL- CN CUST-40000000000 5.2 10 (Released)
PROD-02@ERPO01 0000

[IL- ADR CUST-00000000000 3 10 (Released)
PROD-04@ERPO01 0001

[IL- IMDG CUST-00000000000 3 10 (Released)
PROD-04@ERPO01 0001

[IL- RID CUST-00000000000 3 10 (Released)
PROD-04@ERPO01 0001

[IL- CN CUST-00000000000 3 10 (Released)
PROD-04@ERPO0! 0001

5. Enter the following data on the Mixed Loading tab page:

32

Product Regulation Segregation Key — Seg key 1
[IL-PROD-02@ERPOO1 ADR 5.2

[IL-PROD-02@ERPOO1 IMDG 52

[IL-PROD-02@ERPOO1 RID 5.2

[IL-PROD-02@ERPOOQ1 CN 5.2

[IL-PROD-03@ERPOO1 ADR 3

[IL-PROD-03@ERPOO1 IMDG 3

[IL-PROD-03@ERPOO1 RID 3

[IL-PROD-03@ERPOO1 CN 3
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Product Regulation Segregation Key — Seg key 1
[IL-PROD-04@ERPOOQ1 ADR 3
[IL-PROD-04@ERPOOQ1 IMDG 3
[IL-PROD-04@ERPOOQ1 RID 3
[IL-PROD-04@ERPOOQ1 CN 3
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8 Setting Up Transportation Network in

SAP TM

e Defining Locations [page 34]
e Assigning Locations to Incoterm Locations in SAP TM [page 35]

e Defining Transportation Zones [page 35]

8.1 Defining Locations

Procedure

1. In SAP NetWeaver Business Client, choose

Location

Master Data

Transportation Network » Locations ¥ Define

2. Create locations T1L-CNSHA and I1L-DEHAM with the following data:

Location Location Type Time Zone Address

[IL-CNSHA Port of Shanghai 1002 UTC+8 Yanggao No.1 Road 88
200040 Shanghai
CN

[IL-DEHAM Port of Hamburg 1002 CET Neuer Wandrahm 4
20457 Hamburg
DE

3. Foreach port, enter the geocoordinates as follows:

Location Longitude Latitude

[IL-CNSHA 105 35

[IL-DEHAM 9 51

4. Save your entries.
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8.2 Assigning Locations to Incoterm Locations in SAP TM

1. In SAP NetWeaver Business Client, choose |» Master Data » Transportation Network j» Locations ¥ Assign
Location to Incoterm Location
2. Create an entry with the following data:

Incoterm Location (Free Text) Incoterm Location
Shanghai (IIL-CNSHA) [IL-CNSHA
A Caution

The Incoterm location text can be freely defined in SAP ERP. Make sure that the value in the Incoterm
Location (Free Text) field is exactly the same as the value entered for the Incoterm (in this case FUB) for
the vendor used to create the purchase order. In this scenario, the vendor is I1L-VN-01. To display the
vendor information, call transaction xk01 in the SAP ERP system and choose the Purchasing data
option).

This setting is used during the planning phase.

8.3 Defining Transportation Zones

Context

In this scenario, two transportation zones are used: IIL-CN-CHINA and IIL-DE-GERMANY. If these zones do not
exist in your system, you can use this procedure to define them.

A transportation zone is a business object that groups a number of locations. The system can partly transfer
the properties that you assign to a transportation zone to all its locations. This function reduces the volume of
master data that is stored in the system.

Procedure

1. In SAP NetWeaver Business Client, choose |[r Master Data » Transportation Network » Transportation
Zones » Define Transportation Zones

2. Choose Create and create zone [IL-CN-CHINA as follows:
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Zone Description Zone Type

IIL-CN-CHINA China M Mixed Zone

3. Onthe Zone - Location tab page, create the following locations:
o SUIIL-VN-O1@ERPOO1
o SUIIL-VN-02@ERPOO1
o [|IL-CNSHA

4. Create zone lIL-DE-GERMANY as follows:

Zone Description Zone Type

[IL-DE-GERMANY Germany M Mixed Zone

5. Onthe Zone — Location tab page, create the following locations:

o PL1200@ERPOO1
o |IL-DEHAM
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9 Defining Resources in SAP TM

e Defining Means of Transport [page 37]

e (reating Vehicle Resources [page 39]

e Defining Carrier Profiles [page 40]

e Defining Schedule Types [page 40]

e Defining Schedules [page 41]

e Assigning Transshipment Locations [page 43]

e Defining Transshipment Location Chains [page 43]
® Defining Transportation Lanes [page 44]

e Defining Transport Containers [page 48]

e Defining Resources in TM [page 48]

9.1 Defining Means of Transport

Procedure

1. In Customizing for SAP TM, choose ||» Master Data » Resources » Define Means of Transport

2. Define the following means of transport if they do not yet exist in the system:

Means of Transport IIL_VESSEL IIL_RAIL IIL_FCL

Description Scheduled Vessel Shanghai  European Scheduled Train ~ Truckload (China)
- Hamburg

Transportation Mode 03 SEA 02 RAIL 01 ROAD

Low Speed 20 35 35

Medium Speed 30 45 45

High Speed 40 55 55

Average Speed 30 45 45

Distance Factor 1 1 1
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Means of Transport IIL_VESSEL IIL_RAIL IIL_FCL

Scheduled Means of Trans-  Selected Selected Not selected

port

GIS Quality Not selected Not selected Not selected
i Note

This scenario setup does not use a geographical information system (GIS) and so you must enter a
distance factor and an average speed. If you have a GIS provider connected to your system, you can
select the GIS quality attribute and the three average speeds.

When you save your data, the system may issue a warning that the IGS or GIS tool is unavailable. You
can ignore this message.

3. For means of transport IL_VESSEL, enter the following additional data:

Means of Transport Multires. No. Res.
IIL_VESSEL Selected 15
IIL_RAIL Blank Blank
lIL_FCL Blank Blank

9.2 Assigning Transportation Modes to Equipment Groups

Procedure

1. In Customizing for Transportation Management, choose | Master Data » Resources ¥ Define Equipment
Groups and Equipment Types

2. Select CN Container and choose Mode of Transport Assignment.

3. Choose New Entries and select 2 Rail.

4. Save your entries.
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9.3 Creating Vehicle Resources

Procedure

1. In SAP NetWeaver Business Client, choose

2. Use the following data for lIL-MS:

Master Data » Resources » Define Resource

Field Value
Factory Calendar 01
Time Zone CET

Means of Transport

ITL VESSEL

Start Date/Time 1970-01-01
End Date/Time 9999-12-31
In Service Date 1970-01-01

Continuous Dim.

No dimension

Capacity 14 TEU

3. Use the following data for [IL-EU-RAIL-01:
Field Value
Factory Calendar 01
Time Zone CET
Means of Transport IIL RAIL
Start Date/Time 1970-01-01
End Date/Time 9999-12-31
In Service Date 1970-01-01

Continuous Dim.

No dimension
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Field Value

Capacity 20 TEU

9.4 Defining Carrier Profiles

1. In SAP NetWeaver Business Client, choose |[r Master Data » General » Define Carrier Profile
2. Define a carrier profile for business partner IIL-CR-02.
3. Select the partner and complete the data on the Transportation tab page as follows:

Setting Value
Start Loc./Zone IIL-DEHAM
Dest. Loc./Zone PL1200@ERPOO1
Means of Transport IIL RAIL
Valid On 2010-01-01

i Note

The carrier profile will be created automatically as a by-product of the definition of the trade lanes as
described in 8.9.

9.5 Defining Schedule Types

Procedure

1. In Customizing for Transportation Management, choose |» Master Data » Transportation Network
Schedule » Define Schedule Types

2. Create a new schedule with the following parameters:
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Field Value

Schedule Type IILR

Description IIL Rail Schedule Type
Transp. Mode 02 (Rail)

Document Type L9

For information about creating this document type, see
Defining Freight Order Types [page 70].

Header No. Range 07
Voyage No. Range 01
Offset Time Type A - Absolute

3. Save your entries.

9.6 Defining Schedules

Procedure

1. In SAP NetWeaver Business Client, choose |j» Master Data » Transportation Network » Schedule » Create
Schedule
2. Create schedule IIL-SCHED-OCEAN as schedule type 1000 using the following data:

Means of Trans-

Schedule Description Valid From Valid To port Carrier
[IL-SCHED- Shanghai — Ham- 2012-01-01 2099-01-31 IIL_VESSEL [IL-CR-01
OCEAN burg

3. Enter the following standard port sequence (choose create for each line in the sequence):

Seq Location Port of Entry Port of Exit

10 [IL-CNSHA Selected Not selected
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Seq Location Port of Entry Port of Exit

20 [IL-DEHAM Not selected Selected

4. Enter the departure rules for the voyages as follows:

Rule First Day of LastDayof Depature Day Vessel Departure Factory Cal-
Validity Validity Frequency Time endar
1 2012-01-01 2099-12-31 Weekly 5 IIL_VESSEL  10:00:00 w8

5. Save your schedule.

6. Create schedule T11L-SCHED-TRAIN as schedule type IILR using the following data:

Means of Trans-

Schedule Description Valid From Valid To port Carrier
[IL-SCHED-TRAIN  European Sched- <Today> <Today + 1 IIL_RAIL [IL-CR-02
uled Train Year>

7. Enter the following standard stop sequence (choose create for each line in the sequence):

Transit Duration Cargo Cut-Off

Seq Location (Hours) Time Availability Time Time Zone
10 IIL-DEHAM 4 17:00:00 Not applicable CET
20 SP1200@ERPOO1 Not applicable Not applicable 23:00:00 CET

8. Enter the departure rules as follows:

Rule First Day of Last Day of Monday Wednesday Friday Departure Time Zone
Validity Validity Time

1 Firstday of  Lastdayof  Selected Selected Selected 18:00:00 CET
current current year
month

9. Select the new row and choose Generate Departures.
10. Choose the Departures tab page and check that departures have been created automatically.

11. Save your schedule.
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9.7 Assigning Transshipment Locations

1. In SAP NetWeaver Business Client, choose | Master Data » Transportation Network j» Locations ¥ Assign
Transshipment Location
2. Assignlocation TIL-CNSHA to zone IIL-CN-CHINA and location TIL-DEHAM to zone IIL-DE-GERMANY.

»» Example

To do so, enter IIL-CN-CHINA in the Transportation Zone Selection screen area and enter IIL-CNSHA and
IIL-CN-CHINA in the Transshipment Location Selection screen area.

9.8 Defining Default Route

Procedure

1. In SAP NetWeaver Business Client, choose | Master Data » Transportation Network j» Default Route
Create Default Route

2. Create a new default route with default route type 3000 and enter the following data:

Description Value
Default Route IIL-ROUTE-01 *)1
i Note

If you cannot enter a name for the default route,
change the number range of the header of default
route type 3000 to 07 in Customizing.

Description IIL Default Route
Valid From 01.01.2011

Valid To 31.12.2099
Dangerous Goods Deselect

3. Inthe Transportation Stops section, create the following stages:
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4. Save your entries.

Sequence 10 20 30 40
Location ITL-CN-CHINA ITL-CNSHA IIL-DEHAM IIL-DEHAM
Transport Mode 01 Road 03 Sea 02 Rail
Stage Type 01 - Pick-Up 03 - Main 05 - Delivery
Carriage
Schedule IIL-SCHED-TRAIN
Carrier IIL-CR-03 IIL-CR-01 IIL-CR-02

Planning and
Execution Org.

9.9 Defining Transportation Lanes

Procedure
1. In SAP NetWeaver Business Client, choose |[» Master Data » Transportation Network » Transportation
Lanes » Define Transportation Lane
2. Choose the Intra-Zone/Loc. Transp. Lane tab page, enter Loc-/Transp. Zone IIL-CN-CHINA, and choose
Create.
3. Inthe Means of Transport area, create an entry with the following data:
Means of Trans Start Date End Date
IIL_FCL <01-01-current year> <31-12-next year>
Strategy Value
Relevant to Carrier Selection Blank
Priority / Costs X Neither Costs Nor Priority
Cost Origin Internal Cost
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Strategy

Value

Continuous Movement Type

No Continuous Move

4. Inthe Carrier for Means of Transport area, create an entry with the following data:

Transportation Costs

BP Number Transportation Costs per per KM Priority
[IL-CR-04 1000 KM 1000 1
[IL-CR-03 500 KM 500 2

Save your entries.

6. Choose the Tr.Lane tab page and create two transportation lanes as follows:
o Lane 1: Start Location/Zone SUIIL-VN-O1@ERPQOQI, Dest. Loc./Zone |IL-CNSHA
o Lane 2: Start Location/Zone SUIIL-VN-02@ERPOOI, Dest. Loc./Zone IIL-CNSHA

7. Configure the following settings for both lanes.

In the Means of Transport area, create an entry with the following data:

Means of Trans Start Date End Date
IIL_FCL <01-01-current year> <31-12-next year>
Control Indicator Value
Fixed Trsp. Duration Selected
Fixed Trsp. Distance Selected
9. Enter the following parameters:
Parameters Value
Transportation Distance 1512
Trsp. Duration 34 hrs
Precision 1000
Strategy Value
Relevant to Carrier Selection Selected

Priority / Costs

X Neither Costs Nor Priority
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Strategy Value
Cost Origin Internal Cost
Continuous Movement Type No Continuous Move

10. In the Carrier for Means of Transport area, create a new entry with the following data:

Transportation Costs

BP Number Transportation Costs per per KM Priority
[IL-CR-04 1000 KM 1000 1
[IL-CR-03 500 KM 500 2

11. Choose the Intra-Zone/Loc. Transp. Lane tab page, enter Loc-/Transp. Zone IIL-DE-GERMANY and choose
Create.

12. In the Means of Transport area, create an entry with the following data:

Means of Trans Start Date End Date
[IL_RAIL <01-O1-current year> <31-12-next year>
Control Indicator Value

Fixed Trsp. Duration Selected

Fixed Trsp. Distance Blank

Parameters Value

Transportation Distance 250

Trsp. Duration 2 hrs

Precision 1000

Strategy Value

Relevant to Carrier Selection Selected

Priority / Costs X Neither Costs Nor Priority
Cost Origin Internal Cost

Continuous Movement Type No Continuous Move

13. In the Carrier for Means of Transport area, create an entry with the following data:
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BP Number Transportation Costs

Transportation Costs per

per KM

[IL-CR-02 500

KM 500

14. Save your entries.

15. Choose the Tr.Lane tab page, enter Start Location/Zone I1L-DEHAM, and Dest. Loc./Zone

SP1200QERPO001, and choose Create.

16. In the Means of Transport area, create an entry with the following data:

Means of Trans

End Date

[IL_RAIL

<01-01-current year>

<31-12-next year>

Control Indicator Value
Fixed Trsp. Duration Selected
Fixed Trsp. Distance Selected
Parameters Value
Transportation Distance 250
Trsp. Duration 2 hrs
Precision 1000
Strategy Value
Relevant to Carrier Selection Selected

Priority / Costs

X Neither Costs Nor Priority

Cost Origin

Internal Cost

Continuous Movement Type

No Continuous Move

17. In the Carrier for Means of Transport area, create an entry with the following data:

Transportation Costs

BP Number Transportation Costs per per KM Priority
[IL-CR-02 500 500 1
18. Save your entries.
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9.10 Defining Transport Containers

Procedure

1. In Customizing for SAP TM, choose |» Master Data » Resources » Define Means of Transport

2. Create the following entry:

Mtr Description Transp. Mode Passive

IIL_CONT Container SEA X

3. Save your entries.

9.11 Defining Resourcesin TM

1. In SAP NetWeaver Business Client, choose |[» Master Data » Resources » Define Resource

2. Create the following TU resources as follows. Use resource category T (Transportation) and resource type
9 (Vehicle Resource).

Resource: IIL-CN-TO3-TRUCK1

Field Value

Resource IIL-CN-T03-TRUCK1
Location Blank

Means of Transport IIL FCL

Time Zone UTC+6

Continuous Dimension Mass

Factory Calendar 01

Capacity 40TO

Passive Means of Transport Deselected

Number of Individual Resources Blank
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Field Value

Multiresource Deselected
Resource: [IL-CN-TO3-TRUCK2

Field Value

Resource IIL-CN-T03-TRUCK2
Location Blank

Means of Transport IIL FCL

Time Zone UTC+6

Continuous Dimension Mass

Factory Calendar 01

Capacity 40TO

Passive Means of Transport Deselected

Number of Individual Resources Blank

Multiresource Deselected
Resource: [IL-EU-TO3-RAILO1

Field Value

Resource IIL-EU-T03-RAILO1
Location Blank

Means of Transport IIL_RAIL

Time Zone CET

Continuous Dimension

No Dimension

Factory Calendar 01
Capacity e 25TEU
e 1200TO
e 1000M3
Passive Means of Transport Deselected

Configuration Guide for International Inbound Logistics
Defining Resources in SAP TM

PUBLIC

49



Field Value

Number of Individual Resources Blank
Multiresource Deselected
Resource: [IL-TO3-MS

Field Value
Resource IIL-TO03-MS
Location Blank

Means of Transport

IIL VESSEL

Time Zone

CET

Continuous Dimension

No Dimension

Factory Calendar 01
Capacity 14000 TEU
Passive Means of Transport Deselected
Number of Individual Resources 15
Multiresource Selected
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10 Setting Up Customizing for Output
Management in TM

Prerequisites

You have entered your e-mail data under |» System » User Profile » Own Data 4 or in transaction su01.

More Information

Defining PPF Settings for Output Management [page 51].

10.1 Defining PPF Settings for Output Management

Context

In this Customizing activity, you configure the settings for the post processing framework (PPF). Since PPF is
an output management framework, it helps you set up output that is specific to your installation. PPF
generates output triggers based on the settings you configure for particular application data records. Based on
these configuration settings, the system processes the triggers to send the actual output.

Procedure

1. In Customizing for SAP TM, choose || Cross-Application Components » Processes and Tools for Enterprise
Applications » Reusable Objects and Functions for BOPF Environment » PPF Adapter for Output
Management » Maintain PPF Settings i or enter transaction SPPFCADM.

2. Select Appl. /sCMTMS/TRANSPORTATION and choose Condition Configuration (Transportable Conditions).

3. Select the action profile Actions for Print Documents Sea Freight (/SCMIMS/TOR_PRINT SEA)and action
definition /SCMTMS/PRINT HBL.

4. Onthe Processing Details tab page, select the Recipients subtab page.
Enter your e-mail information and choose U Internet address as the recipient type.

6. Onthe Printer subtab page, enter your printer in the Printer field.
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7. Once the Customizing settings for action profiles have been completed, you will need to add the action
profile /SCMTMS/TOR PRINT SEA to your freight order type in the output profile field.
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11 Setting Up SAP Event Management

Use

i Note

For technical information about how SAP Event Management is integrated with SAP Transportation
Management, see the dedicated integration guide.

More Information

Assigning Users to Web Transactions [page 53].

11.1 Assigning Users to Web Transactions

Context

In this Customizing activity, you assign a user to a Web interface transaction and to an existing user profile so
that the appropriate Web layout for sending event messages and querying event handler information is
available to the user.

Procedure

1. In Customizing for SAP Event Management, choose |» Event Messages, Status Queries, and Web Interface
Web Interface » Assign User Profiles and Web Interface Transactions to Users
2. Enter your user name.

3. Assign the Web interface transaction, user profile, and order Web to your user as follows:
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Web Int. Tran.

User Profile

Order Web

ODT30_CONS_FO

ODT30_CONSIGNEE_FO

ODT20_CONS_FU

ODT20_CONSIGNEE_FU

ODT20_SHIP_FO

ODT20_SHIPPER_FO

ODT20_SHIP_FU

ODT20_CONSIGNEE_FU
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12 Creating Organizational Data in TM

o

In SAP NetWeaver Business Client, choose |» Master Data » Organization ¥ Create Organization and
Staffing
Enter the validity period of January 1, 2010 to December 31, 9999 and choose Continue.
Create the purchasing organization I/L.-PORG-1 as follows:
1. Onthe Basic Data tab page, press the create button and enter organizational unit IIL-PORG-1 and the
description IIL CHEMIC DE Purch. Org.
2. Onthe Org. Data tab page, enter the following data:

Field Value

Org. Unit Function Purchasing
Org. Unit Role Organization
Org. ID IIL-PORG-1

3. Choose the Address tab page and enter the city Hamburg and the country DE.

Select your purchase organization in the top-right window and choose Create.

In the Choose Relationship dialog box, choose Is line supervisor of.

Create purchasing group IIL.-PGRP-1 as follows:

1. Onthe Basic Data tab page, enter organizational unit IIL-PGRP-1 and the description IIL Purchase
Group.

2. Choose the Org. Data tab page and enter organizational unit function 2 (purchasing) and
organizational unit role 3 (group).

3. Choose the Address tab page and enter city Hamburg and country DE.

Save your entries.

i Note

Use the purchasing group organization ID TIL.-PGRP-01 as shown on the Org. Data tab page for SAP TM
transactions.
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13 Assignhing Business Partners to
Purchasing Organizations

Procedure

In SAP NetWeaver Business Client, choose ||» Master Data » General » Define Business Partner

Edit business partner I1L-CR-04.

In the Display in BP role field, choose Carrier.

> w o

On the Vendor Org. Data tab page, enter the purchasing organization by using the input help (). Select
the organization with the description IIL CHEMIC DE Purch. Org (see Creating Organizational Data in TM
[page 55]).

5. Save your entries.
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14 Setting Up Customizing in SAP TM

e Defining Conditions [page 57]

® (reating Incompatibilities [page 58]

e Defining Incompatibility Settings [page 59]

e Defining Freight Unit Types [page 60]

e Defining Freight Unit Building Rules [page 61]

e Defining Conditions for Freight Unit Building Rule Determination [page 63]
e Defining Order-Based Transportation Requirement Types [page 64]

e Defining Delivery-Based Transportation Requirement Types [page 65]
e Defining Conditions for OTR Type Determination [page 66]

e Defining Conditions for DTR Type Determination [page 68]

e Defining Freight Settlement Document Types [page 69]

® Mapping Organizational Units for Purchasing [page 12]

e Defining Freight Order Types [page 70]

e Defining Freight Booking Types [page 73]

14.1 Defining Conditions

Context

In this procedure, you define a condition to determine dependent values for incompatibilities.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose ||* Application Administration » General Settings
Conditions j» Create Condition
2. Choose Continue.

3. Inthe header area, enter the following data:

Field Value

Condition IIL-INC-COND-TRA-GRP
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Field Value

Description Incompatible Transportation Groups
Condition Type /SCMTMS/INC_TR ITEM

Origin of Condition Direct Business Object Access

4. On the Data Access Definition tab page, choose Create and enter the following data:

Column Position Data Access Definition for Condition Data Element Used for Input Help

00 /SCMTMS/TRQ TRAN GRP /SCMTMS/PROD TRANSP GRP CD

5. Inthe area below the table, enter the following data:

Field Value

Name of BO Used in Condition /SCMTMS/TRQ
Name of BO Node Used in Condition ITEM

Name of Field of the BO Node PRD_TRANSP_GRP

6. Save your entries.

14.2 Creating Incompatibilities

Context

You use this procedure to define the compatibility of planning data that the system is to take into account
during transportation planning, for example:

® Freight units with different Incoterms must not be transported together.
e Refrigerated goods must only be transported in appropriate means of transport (refrigerated trucks).

e A certain means of transport cannot be unloaded at a location, since the location does not have a suitable
loading ramp.

In this way, you can control the assignment of freight units to transportation plans (in other words, planned
transportation activities) and transportation plans to means of transport, for example.
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Procedure

1. In SAP NetWeaver Business Client (NWBC), choose ||» Application Administration # Planning » General
Settings » Incompatibility Definitions » Create Incompatibility
2. Inthe Incompatibility Definition screen area, enter the following data:
Field Value
Incompatibility IIL INCOMP_TRANSP_ GROUP
Description Incompatible Transportation Groups
Determination Method Condition-Based Incompatibility
Identical Values Only Selected
Incompatibility Area 04 Freight Unit Building
Incompatibility Type 52 Transportation Request Item
Manual Violation Incompatibility Must Not Be Violated
Automatic Violation Incompatibility Must Not Be Violated
In the Conditions screen area, enter the first condition IIL-INC-COND-TRA-GRP.
4. Save your entries.
14.3 Defining Incompatibility Settings
Procedure
1. In SAP NetWeaver Business Client (NWBC), choose ||» Application Administration ¥ Planning ¥ General
Settings » Incompatibility Settings » Create Incompatibility Settings
2. Inthe General Data screen area, enter the following data:
Field Value
Incompatibility Settings IIL-INCOMP-SET-TRA-GROUP
Description Incompatible Transportation Groups
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Field Value

Incompatibility Area Freight Unit Building

3. Inthe Incompatibility Selection table, enter the following data:

Incompatibility Violation in Manual Planning Violation in Automatic Planning

IIL_INCOMP_TRANSP_GROUP According to Incompatibility Definition According to Incompatibility Definition

4. Save your entries.

14.4 Defining Freight Unit Types

Prerequisites

You have defined the freight order type as II19. For more information, see Defining Freight Order Types [page

70]

Procedure

1. In Customizing for SAP TM, choose |* Planning # Freight Unit » Define Freight Unit Types

2. Create a new freight unit type as follows:

1

60

In the header area, enter freight unit type I1L1 and the description Freight Unit - Inbound
Logistic.

In the Change Controller Settings screen area, enter DEF_CHACO in the Default Change Strategy field.
In the Execution Settings screen area, select 3 Execution Tracking with External Event Management in
the Execution Track. Relevance.

In the Event Management Settings subscreen area, enter the application object type 0ODT30 and the last
expected event ARRIV_DEST.

In the Additional Settings screen area, enter the dangerous goods profile IIL_DG_PR1 and set the rule
for the PU/DLV window to A Earliest Pick-Up at Req. Day/Latest Delivery at Req. Day.

In the Number Range Settings screen area, select | Draw Numbers Immediately as the time for drawing
and specify number range interval 02.

In the Direct Shipment Options screen area, enter the direct shipment option type as No Determination
of Direct Shipment and the freight order type as /IL9 Int. Inbound Logistics Freight Order.

In the Organizational Unit Determination screen area, enter purchasing organization IIL-PORG-1.
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3. Save your entries.

14.5 Defining Freight Unit Building Rules

Context

In this procedure, you define a freight unit building rule that determines how the system is to consolidate
freight units. Freight units are the smallest units in transportation and cannot be split during transportation.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |* Application Administration » Planning » General
Settings j» Freight Unit Building Rule

2. Choose Create Freight Unit Building Rule.

3. Enter the following data:

On the General Data tab page:

Field Value

Freight Unit Building Rule IIL-FUBR-20FOOT

Description Inbound Logistics 20’ Container
Document Type IIL1

Incompatibility Settings IIL-INCOMP-SET-TRA-GROUP

Freight Unit Building Strategy Consolidate as Much as Possible

Critical Quantity Gross Weight

Item Split Allowed Selected

Equipment Group CN

Equipment Type 22G0
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On the Advanced Settings tab page:

Field Value

Process Controller Strategy FUB_DG

On the Planning Quantities tab page, the system automatically completes the data using values specified in
Customizing for the container. The split quantity is the maximum payload value from the corresponding
equipment type.

4. Save your entries.

5. Create a second freight unit building rule using the following data:

On the General Data tab page:

Field Value

Freight Unit Building Rule IIL-FUBR-40FOOT

Description Inbound Logistics 40’ Container
Document Type IILl

Incompatibility Settings IIL-INCOMP-SET-TRA-GROUP

Freight Unit Building Strategy Consolidate as Much as Possible

Critical Quantity Gross Weight

Item Split Allowed Selected

Equipment Group CN

Equipment Type 42G0

On the Advanced Settings tab page:

Field Value

Process Controller Strategy FUB_DG

On the Planning Quantities tab page, the system automatically completes the data using values specified in
Customizing for the container. The split quantity is the maximum payload value from the corresponding
equipment type.
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14.6 Defining Conditions for Freight Unit Building Rule

Determination

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose
Conditions ¥ Create Condition

2. Enter the following data and choose Continue:

Application Administration » General Settings

Field Value
Condition ITL-FUBR-DETCON-VEND
Description Inbound Logistics: FUBR Based on Vendor

Condition Type

/SCMTMS/FUBR

Origin of Condition

Condition Based on BRFplus Decision Table

3. Choose the Data Access Definition pushbutton and enter the following data:

Column Position Data Access Definition for Condition Data Element Used for Input Help

00 Blank

/SCMTMS/SOURCE_LOCATION

4. Inthe area below the table, enter the following data:

Field Value

Name of BO Used in Condition /SCMTMS/TRQ
Name of BO Node Used in Condition ROOT

Name of Field of the BO Node SRC_LOC_1ID

5. Return to the decision table and create the following entries:

Srce Loc.

FUB Rule

SUIIL-VN-O1@ERPOO1

[IL-FUB-20FOOT
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Srce Loc.

FUB Rule

SUIIL-VN-02@ERPOO1

[IL-FUB-40FOOT

14.7 Defining Order-Based Transportation Requirement

Types

Context

In this procedure, you specify types of order-based transportation requirements (OTR). You then use these
types to define certain parameters of the OTR that influence how the system processes this business
document.

Procedure

1

2.

In Customizing for SAP TM, choose |f¢ Integration » ERP Logistics Integration ¥ Order-Based

Transportation Requirement

Choose New Entries.

3. Enter the following data:

64

Define Order-Based Transportation Requirement Types

Field Value

OTR Type IIL2

Description PO Transport Requirements
Number Range Interval 01

Automatic Freight Unit Building Selected

EM Web Interface Transaction

ODT20_SHIP_FU

EM Integration Active Selected
DG Profile IIL DG_PR1
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Field Value

Propagate Changes: B Synchronous Propagation of Changes; Fallback to Asyn-
chronous

Plan on Req/Cnf Qty 01 Plan on Requested Quantities

FU Building Rule Condition IIL-FUBR-DETCON-VEND

4. Save your entries.

14.8 Defining Delivery-Based Transportation Requirement
Types

Context

In this procedure, you specify types of delivery-based transportation requirements (DTR). You then use these
types to define certain parameters of the DTR that influence how the system processes this business
document.

Procedure

1. In Customizing for SAP TM, choose ||* Integration » ERP Logistics Integration ¥ Delivery-Based
Transportation Requirement » Define Delivery-Based Transportation Requirement Types

2. Choose New Entries and enter the following data:

Field Value

Transp. Reqmt Type IIL3

Description Int. Inbound Logistics — Delivery
Number Range Interval 02

Automatic Freight Unit Building Selected

EM Web Interface Transaction ODT20_SHIP_FU
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Field Value

DG Profile IIL DG_PR1

Propagate Changes B Synchronous Propagation of Changes; Fallback to Asyn-
chronous

FU Building Rule Condition IIL-FUBR-DETCON-VEND

3. Save your entries.

14.9 Defining Conditions for OTR Type Determination

Prerequisites

You have defined the OTR document types.

Context

When the SAP TM system receives a sales order, it creates an order-based transportation requirement (OTR).
This requirement must be mapped to a document in the SAP TM system, which then determines the
subsequent workflow process.

In this configuration step, the OTR type is determined when an order is transferred from SAP ERP to SAP TM.

Procedure

1. Onthe SAP Easy Access screen, call transaction NwWBC to open the SAP Business Client.

2. Choose |» Application Administration » General Settings # Conditions » Create Condition

3. Choose Continue.

i Note

If the system issues a message stating that the condition already exists, continue this process from the
point at which you maintain values on the Decision Table tab page.

4. Onthe New Condition Definition screen, enter the data below:
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In the General Data screen area:

Field Description Value

Condition Condition type supplied by the system ZzZOTR TYPE

Description Description of the condition type OTR Type Determination
Condition

In the Settings screen area:

Field Description Value

Condition Type

Condition type supplied by the system

/SCMTMS/OTR_TYPE

Origin of Condition

Source of the condition information

Condition based on BRFplus Decision
Table

5. Choose the Data Access Definition tab page and enter the following data:

Field Description Value

Line 10 Select this row for further mainte- Data Access Definition: /scMTMS /
nance TRQ ORD CAT

Line 20 Select this row for further mainte- Data Access Definition: /scMTMS /

nance

TRQ ORD TYPE

6. Choose the Decision Table tab page and enter the following data:

Field Description Value
Proc Type Procedure type (incoming parameter) IIL4
Parameter: “is equal to”
BseDoc. Ty. Incoming base document type Parameter: “is equal to”
Value: 001 — Purchase Order
OTR Type Specify the data for integration here = IIL2
the document type that is identified
and used in SAP TM for OTR.
i Note

To enter values on the Decision Table tab page, you may have to switch to edit mode and choose Insert

New Row.

7. Save your changes.
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Results

You have configured the integration settings between the incoming sales document and the OTR document
type.

14.10 Defining Conditions for DTR Type Determination

Procedure

1. Onthe SAP Easy Access screen, call transaction NwWBC to open the SAP Business Client.

2. Choose |» Application Administration » General Settings # Conditions » Create Condition

3. Choose Continue.

i Note

If the system issues a message stating that the condition already exists, continue this process from the
point at which you maintain values on the Decision Table tab page.

4. Onthe New Condition Definition screen, enter the data below:

In the General Data screen area:

Field Description Value

Condition Condition type supplied by the system 2zZDTR TYPE

Description Description of the condition type DTR Type Determination
Condition

In the Settings screen area:

Field Description Value

Condition Type Condition type supplied by the system /SCMTMS/DTR TYPE

Origin of Condition Source of the condition information Condition based on BRFplus Decision
Table

5. Choose the Data Access Definition tab page and enter the following data:
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Field Description Value

Line 10 Select this row for further mainte- Data Access Definition: /scMTMS /
nance TRQ_ORD_CAT

Line 20 Select this row for further mainte- Data Access Definition: /scMTMS /
nance TRQ ORD TYPE

6. Choose the Decision Table tab page and enter the following data:

Proc Type DTR Type
LF 13
EL I3

i Note

To enter values on the Decision Table tab page, you may have to switch to edit mode and choose Insert
New Row.

7. Save your changes.

14.11 Defining Freight Settlement Document Types

Context

In this procedure, you define types of freight settlement documents (FSDs). You can use these types to specify
certain parameters for certain types of FSDs, for example:

e Number ranges of freight settlement documents
® Freight settlement document categories
® Tracking of changes

You can also assign default FSD types to FSD categories. The system uses the default FSD type if you do not
enter a FSD type when creating an FSD.

Procedure

1. In Customizing for SAP TM, choose | Settlement ¥ Freight Settlement » Define Freight Settlement
Document Types.
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2. Add a new entry as follows:

Field Value

FSD Type IILS

FSD Category 10 Freight Settlement Documents

Description Carrier Invoice Freight Settlement
No. Range Interval 01

Weight UoM TO

Default Volume UoM M3

Default Quantity UoM EA

Output Profile /SCMTMS/TOR_INV_PREP

Add. Output Profile /SCMTMS/SFIR PRINT

14.12 Defining Freight Order Types

Context

In this Customizing activity, you define new freight order types that contain an enhanced save strategy. These
freight order types are used to create freight orders for the pre-carriage and on-carriage stages. Execution and
settlement for these stages are based on the freight orders.

Procedure

1. In Customizing for Transportation Management, choose |# Freight Order Management » Freight Order
Define Freight Order Types

2. Create a new freight order type for the pre-carriage stage using the following data:
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Field Value
Freight Order Type IILO
Description Int. Inbound Logistics FO (CN)

Basic Settings

Freight Order Can Be Subcontracted

02 - Not Relevant for Subcontracting

Shipper/Consignee Determination

P Determination based on Predecessor

Documents
Enable Settlement Select
Enable Charge Calculation Select

Number Range Settings

Time for Drawing

I Draw Number Immediately

Number Range Interval 04
Change Controller Settings
Default Change Strategy DEF_CHACO

Execution Settings

Execution Track. Relev.

3 Execution Tracking with External

Event Management

Immediate Processing Select
Propagate Execution Info Select

Event Management Settings

Application Object Type ODT30_TO
Last Exp. Event ARRIV_DEST
Default MTr Determination

Default MTr for Type IIL RAIL
Transportation Mode 02

Tendering Settings

Use Default Settings Select
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Field Value
Output Options
Output Profile /SCMTMS/TOR_PRINT_ROAD

Additional Settings

Dangerous Goods Profile

IIL_DG_PR1

Default FSD Type

IILS

Organizational Unit Determination

Purchase Org.

<IIL-PORG-1>

3. Save your entries.

4. Create a second freight order type for the on-carriage stage using the following data:

Field Value
Freight Order Type IIL6
Description Int. Inbound Logistics FO (DE)

Basic Settings

Freight Order Can Be Subcontracted

01 - Relevant for Subcontracting

Shipper/Consignee Determination

P Determination Based on Predecessor

Documents
Enable Settlement Select
Enable Charge Calculation Select

Number Range Settings

Time for Drawing

I Draw Number Immediately

Number Range Interval 04
Change Controller Settings
Default Change Strategy DEF_CHACO

Execution Settings

Execution Track. Relev.

3 Execution Tracking with External

Event Management
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Field Value
Immediate Processing Select
Propagate Execution Info Select

Event Management Settings

Application Object Type ODT30_TO

Last Exp. Event ARRIV_DEST

Default MTr Determination

Default MTr for Type IIL FCL

Transportation Mode 01

Tendering Settings

Use Default Settings Select
Output Options
Output Profile /SCMTMS/TOR_PRINT_ ROAD

Additional Settings

Dangerous Goods Profile IIL DG_PR1

Default FSD Type IILS5

Organizational Unit Determination

Purchase Org. <IIL-PORG-1>

5. Save your entries.

14.13 Defining Freight Booking Types

Context

You use the freight booking that is created from this document type as the main document in this scenario. In
particular, the freight booking is used to plan, execute, and settle the main-carriage stage.

Configuration Guide for International Inbound Logistics
Setting Up Customizing in SAP TM PUBLIC 73



Procedure

1

In Customizing for SAP TM, choose |f¢ Freight Order Management » Freight Booking ¥ Define Freight

Bo

oking Types

2. Create a freight booking type for execution booking as follows:

1

Enter the freight booking type II17 and the description Ocean Booking - Int. Inbound
Logistics.
In the Transportation Mode field, choose 3 Sea.

In the Basic Settings screen area, set the Shipper/Consignee Determination field to L Determine Based
on First and Last Location and select the Booking Can Be Deleted checkbox.

In the Charge Calculation and Settlement Document Settings area, select the Enable Charge Calculation
checkbox.

Enter IIL5 Carrier Invoice Freight Settlement asthe Default FSD Type.

6. Inthe Change Controller Settings screen area, enter the default change strategy DEF_CHACO.

In the Execution Settings screen area:
o Setthe Exec. Track. Relevance field to 3 Execution Tracking with External Event Management.
o Set the Immediate Processing field to X Life Cycle Is to Be Set to “In Process” Immediately.
o Select the Propagate Execution Info checkbox.
o Enter the application object type oDT30_TO.
© Enter the last expected event ARRIV_DEST.
In the Additional Settings screen area, enter the dangerous goods profile IIL._DG_PR1 and the Web
dynpro application configuration /SCMTMS/FRE_BOOK_OCEAN.
In the Number Range Settings screen area:
o Set the Time for Drawing field to | Draw Numbers Immediately.
o Enter number range interval 05.

10. In the Service Definition screen area, set the Consolidation (Source / Dest.) fields to P Without

11.

Consolidation.
In the Output Options screen area, enter the output profile /SCMTMS/TOR_PRINT SEA.

12. In the Organization Unit Determination screen area, enter the purchasing organization that you created

in Creating Organizational Data in TM [page 55]. In this scenario, the purchasing organization is IIL-
PORG-1.

3. Save your entries.

4. Create a new freight booking type for pre-booking as follows:
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1

Enter the freight booking type II18 and the description Ocean Pre-Booking - Int. Inbound
Logistics.
In the Transportation Mode field, choose 3 Sea.

In the Basic Settings screen area, set the Shipper/Consignee Determination field to L Determine Based
on First and Last Location and select the Booking Can Be Deleted checkbox.

In the Change Controller Settings screen area, enter the default change strategy DEF_CHACO.

In the Execution Settings screen area:

o Set the Exec. Track. Relevance field to 3 Execution Tracking with External Event Management.
o Setthe Immediate Processing field to X Life Cycle Is to Be Set to “In Process” Immediately.

© Enter the application object type oDT30_TO.

© Enter the last expected event ARRIV_DEST.

Configuration Guide for International Inbound Logistics
PUBLIC Setting Up Customizing in SAP TM



6. Inthe Additional Settings screen area:
© Enter the dangerous goods profile IIL_DG_PRI.
o Choose the default FSD type /IL5 Carrier Invoice Freight Settlement.
o Enter the Web dynpro application configuration /SCMTMS/FRE_BOOK_OCEAN.
7. Inthe Number Range Settings screen area:
o Set the Time for Drawing field to | Draw Numbers Immediately.
o Enter number range interval 05.
o Enter the HBL number range 05.
8. Inthe Service Definition screen area, set the Consolidation (Source) and Consolidation (Dest.) fields to
P - Without Consolidation.
9. Inthe Output Options screen area, enter the output profile /SCMTMS/TOR_PRINT SEA.
10. In the Organization Unit Determination screen area, enter the purchasing organization that you created
in Creating Organizational Data in TM [page 55]. In this scenario, the purchasing organization is IIL-
PORG-1.

5. Save your entries.
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15 Setting Up Application Administration

e Defining Carrier Selection Settings [page 76]
e Defining Capacity Settings [page 77]

e Defining Optimizer Settings [page 78]

e Defining Planning Profiles [page 79]

e Defining Selection Profiles [page 81]

15.1 Defining Carrier Selection Settings

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |* Application Administration » Planning ¥ Planning
Profile Settings ¥ Carrier Selection Settings ¥ Create Carrier Selection Settings
2. Create carrier selection setting lIL-CAR-SEL-OCSP with the following data:

Field Value
Carrier Selection Settings IIL-CAR-SEL-OCSP
Description Int. Inbound Logistics Ocean Carrier

Selection Profile

Check Incompatibilities Deselected

Type of Carrier Selection Settings General Carrier Selection
Alloc. Usage Use Transportation Allocations
BS Usage Do Not Use Business Shares
Strategy Costs

Carrier Cost Origin Use Internal Costs

3. Onthe Advanced Settings tab page, enter the following data:
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Field Value
Planning Strategy TSPS_DEF
Optimizer Runtime 6

Action for Manual Rankings Remove

Transportation Charge Interpretation

Accept Carrier with Charges of Zero

Action After Carrier Selection Run

No Action

Continuous Move Type

Use Transportation Lane Settings

Check Dist. and Dur.

Selected

CM Cost Recalculation of TCM

No Recalculation

4. Save your entries.

15.2 Defining Capacity Settings

Context

You can use this procedure to define a user-specific grouping of capacities that is taken into account during
transportation planning.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |[» Application Administration » Planning » Planning
Profile Settings » Capacity Selection Settings » Create Capacity Selection Settings
2. Create capacity selection setting [IL-CAP-SEL-STD with the following data:

Description: Inbound Logistic — Capa. Prof.

Vehicle Resource

Veg. Res. Sel. Attr. Sign Option Lower Limit

VEHICLERES_ID Inclusive Pattern 1%g
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Schedules
Attr. For Schd. Sel. Sign Option Lower Limit
SCH_ID Inclusive Pattern I

3. Save your entries.

15.3 Defining Optimizer Settings

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |* Application Administration » Planning ¥ Planning
Profile Settings » Optimizer Settings ¥ Create Optimizer Settings.

2. Create optimizer setting I11.-0PT-SET-STD using the following data:

Field Value

Optimizer IIL-OPT-SET-STD

Description Inbound Logistics - Optimizer Settings
Planning Strategy VSR_DEF

FO Building Rule New Freight Order when Resource is Empty

Accept Transp. Prop

Save Route and Freight Documents

Planning Strategy for Transp. Prop VSR_DEF
Max. Number of Trans Proposals 5

Max. No. of Parallel Processes 2
Maximum No of Transshipment Loc 2
Maximum Runtime (Seconds) 10

Consider Capacity During Optimization

Consider Capacities During Optimization

3. Save your entries.
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15.4 Defining Planning Profiles

Context

In this procedure, you define a planning profile that contains all of the relevant settings for optimizer planning
and creating transportation proposals using the routing guide.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose ||» Application Administration » Planning ¥ Planning
Profiles » Create Planning Profile
2. Onthe Planning Profile tab page, create planning profile II1L-PLAN-PROF-STD as follows:

1. Inthe General Data screen area, enter planning profile IIL-PLAN-PROF-STD and the description
Inbound Logistic Planning Prof.

2. Inthe Planning Horizon screen area, enter the following data:

Field Value
Duration in Days 180
Round Horizon to Full Days Selected
Time Zone for Rounding the Horizon CET

3. Inthe Profile Assignments screen area, enter the following data:

Field Value

Capacity Selection Settings IIL-CAP-SEL-STD
Optimizer Settings IIL-OPT-SET-STD
Carrier Selection Settings IIL-CAR-SEL-OCSP

4. Inthe Business Document Type screen area, enter the following data:

Field Value

Type Determination Rule Defined per Category in Planning Profile
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Field Value
Default Type for Road FO IIL6
Default Type for Bookings (Ocean) IIL7
Default Type for Road FO IILY

5. Inthe Manual Planning screen area, enter the following data:

Field Value
Manual Planning Strategy VSRI_DEF
Consider Fixing Status Error When Changing Fixed Document

6. Inthe Scheduling screen area, enter the following data:

Field Value

Scheduling Strategy VSS_DEF

Consider Freight Unit Dates Do Not Consider Freight Unit Dates
Scheduling Direction Backward

7. Inthe Check screen area, enter the following data:

Field Value
Check Strategy VSR_CHECK
Take Capacities into Account Warning

8. Inthe Loading and Unloading screen area, enter the following data:

Field Value
Dependence Freight Unit and MTr Independent
Loading/Unloading Duration 00:00:00

9. Save your entries.
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15.5 Defining Selection Profiles

Context

In this procedure, you create selection profiles, which define the selection of the freight units based on
geography, pick-up dates, and delivery dates. You need to create three selection profiles for each stage. This
leads to stage level planning, so that transportation planners with regional expertise may select only those
transportation requirements for which they are responsible.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose | Application Administration ¥ Planning ¥ Selection
Profile Attributes » Geographical Selection Attributes » Create Geographical Selection Attributes
2. Create selection profile IIL.-GEO-SEL-MAIN for main carriage as follows:

1. Inthe General Data screen area, enter the following data:

Field Value

Geographical Sel. Attributes IIL-GEO-SEL-MAIN

Description Inbound Logistic - MainlLeg Selection
Profile

Both Locations Selected

2. Choose the Source Zones tab page and enter the following data:

Sign Option Lower Value Upper Value

Inclusive = IIL-CN-CHINA Blank

3. Choose the Destination Locations tab page and enter the following data:

Sign Option Lower Value Upper Value
Inclusive = [IL-DEHAM Blank
Inclusive = SP1200@ERPOO1 Blank

3. Create selection profile I11L.-GEO-SEL-PRE for pre-carriage as follows:
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1. Inthe General Data screen area, enter the following data:

Field Value

Geographical Sel. Attributes IIL-GEO-SEL-PRE

Description Inbound Logistic - Pre-Carriage
Both Locations Selected

2. Choose the Source Locations tab page and enter the following data:

Sign Option Lower Value Upper Value

Inclusive Within Range SUIIL-VN-O1@ERPOO1 SUIL-VN-02@ERPOO1

3. Choose the Destination Locations tab page and enter the following data:

Sign Option Lower Value Upper Value

Inclusive e IIL-CNSHA Blank

4. Create selection profile 111.-GEO-SEL-ON for on-carriage as follows:

1. Inthe General Data screen area, enter the following data:

Field Value

Geographical Sel. Attributes [IL-GEO-SEL-ON

Description Inbound Logistic - On-Carriage
Both Locations Selected

2. Choose the Source Locations tab page and enter the following data:

Sign Option Lower Value Upper Value

Inclusive = |IL-DEHAM Blank

3. Choose the Destination Locations tab page and enter the following data:

Sign Option Lower Value Upper Value

Inclusive = SP1200@ERPOO1 Blank

5. In SAP NetWeaver Business Client (NWBC), choose |[» Application Administration ¥ Planning ¥ Selection
Profile Attributes » Additional Selection Attributes » Create Additional Selection Attributes
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6. Create additional selection attributes I1I11L-ADD-SEL-EXCLUDE-PLANNED by entering the following data in
the General Data screen area:

Field Value

Additional Sel. Attributes IIL-ADD-SEL-EXCLUDE-PLANNED
Description Exclude Planned Req.

Planned Requirements Exclude in Selection

7. In SAP NetWeaver Business Client (NWBC), choose |[» Application Administration ¥ Planning ¥ Selection
Profiles » Create Selection Profile
8. Create selection profile I1L.-GEN-SEL-MAIN-WO-TIME for main carriage with the following data:

Field Value

Selection Profile IIL-GEN-SEL-MAIN-WO-TIME

Description Inbound Logistics - Main Carriage
Maximum Number of Selected Objects 100

Geographical Sel. Attributes IIL-GEO-SEL-MAIN

Additional Sel. Attributes IIL-ADD-SEL-EXCLUDE-PLANNED

9. Create selection profile IIL-GEN-SEL-PRE-WO-TIME for precarriage with the following data:

Field Value

Selection Profile IIL-GEN-SEL-PRE-WO-TIME
Description Inbound Logistics — Pre-Carriage
Maximum Number of Selected Objects 42

Geographical Sel. Attributes IIL-GEO-SEL-PRE

Additional Sel. Attributes IIL-ADD-SEL-EXCLUDE-PLANNED

10. Create selection profile IIL-GEN-SEL-ON-WO-TIME for on-carriage with the following data:

Field Value
Selection Profile IIL-GEN-SEL-ON-WO-TIME
Description Inbound Logistics — On-Carriage
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Field

Value

Maximum Number of Selected Objects

42

Geographical Sel. Attributes

ITIL-GEO-SEL-ON

Additional Sel. Attributes

IIL-ADD-SEL-EXCLUDE-PLANNED

Save your entries.

PUBLIC
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16 Setting Up Transportation Charge

Management

e Defining Calculation Sheets [page 85]
e Defining Freight Agreement Types [page 87]
e Defining Freight Agreements [page 88]

16.1 Defining Calculation Sheets

Context

You use this procedure to define a calculation sheet. This informs the TM system of the transportation charges
to be calculated and how to calculate them. This helps to bill the customer for transportation services and to

pay the supplier for subcontracted transportation services.

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |» Master Data
Product Catalogs » Calculation Sheets j» Create Calculation Sheet

2. Choose Continue without entering a template.

3. Create calculation sheet IIL-TCCS-FCL-SHIP.

4. Enter description IIL-TCCS-FCL-SHIP.

Charge Usage: Service Provider.

5. Inthe ltems screen area, choose |» Insert » Single Item . and enter the following data

Charge Management and Service

Line No. Instruction Type Charge Type Amount Currency Resolution Base
20 Standard THCO 156 ushD STAGE
30 Standard IPSO 16 usb BOOKING
40 Standard BSF 850 usb STAGE
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Line No. Instruction Type Charge Type Amount Currency Resolution Base
50 Standard THCD 156 EUR STAGE
60 Standard IPSD 16 EUR BOOKING

6. Create calculation sheet IIL-TCCS-ONCARR-RAIL.
Enter description IIL-TCCS-ONCARR-RAIL.

Charge Usage: Service Provider.

8. Inthe ltems screen area, choose |» Insert » Single Iltem i and enter the following data

Line No. Instruction Type Charge Type Amount Currency Resolution Base

20 Standard BSF 337 EUR STAGE

9. Create new calculation sheet lIL-TCCS-CN-A184.
10. Enter description IIL-TCCS-CN-A184.

Charge Usage: Service Provider.

11. Inthe ltems screen area, choose ||» Insert » Single Item i and enter the following data

Line No. Instruction Type Charge Type Amount Currency

20 Standard BASE 500 EUR

12. Create new calculation sheet IIL-TCCS-CN-A183.
13. Enter description IIL-TCCS-CN-A183.

Charge Usage: Service Provider.

14. Enter the following data:

Line No. Instruction Type Charge Type Amount Currency

20 Standard BASE 600 EUR

15. Save your entries.
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16.2 Defining Freight Agreement Types

Context

You use this Customizing activity to define freight agreement types. You must specify a freight agreement type
when you create freight agreements.

Procedure

1. In Customizing for SAP TM, choose ||» Transportation Management » Master Data » Agreements and
Service Products » Define Freight Agreement Types

2. Enter the following values that will apply to all your freight agreements.

Field Description User Action and Values

Type Blank IILA

Short Description Blank IIL Freight Agreement
Type

Dflt Type Default Type Deselected

TrackChang Blank Deselected

Mul Pty Blank Deselected

Txt Schema Blank Blank

Calc. Sheet Template Blank Blank
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16.3 Defining Freight Agreements

Procedure

1. In SAP NetWeaver Business Client (NWBC), choose |* Freight Agreement Management » Freight
Agreements.
2. Create new freight agreement I11.-FA-SEA-CAR-01 as follows:
1. Onthe New Freight Agreement screen, enter the type IILA and choose Continue.
2. Onthe General Data tab page, enter the following data:

Field Value

Agreement [IL-FA-SEA-CAR-01
Description IIL-FA-SEA-CAR-01
Time Zone CET

Valid From As required

Valid To As required

Purchase Organization IIL-PORG-1

Carrier IIL-CR-01

3. Inthe ltems screen area, add calculation sheet ITL.-TCCS-FCL-SHIP to the table.

4. Choose ||r Set Status » Released
5. Save the freight agreement.

3. Create freight agreement 1I11L.-FA-RAIL-CAR-01 as follows:

1. Onthe New Freight Agreement screen, enter the type IILA and choose Continue.

2. Onthe General Data tab page, enter the following data:

Field Value

Agreement IIL-FA-RAIL-CAR-01
Description IIL-FA-RAIL-CAR-01
Time Zone CET
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Field Value

Valid From As required
Valid To As required
Purchase Organization IIL-PORG-1
Carrier IIL-CR-02

3. Inthe ltems screen area, add calculation sheet IT1L.-TCCS-ONCARR-RAIL to the table.

4. Choose |» Set Status » Released

5. Save the freight agreement.

4. Create freight agreement 111L.-FA-CN-A183-01 as follows:

1. Onthe New Freight Agreement screen, enter the type IILA and choose Continue.

2. Onthe General Data tab page, enter the following data:

Field Value

Agreement IIL-FA-CN-A183-01
Description IIL-FA-CN-A183-01
Time Zone CET

Valid From As required

Valid To As required

Purchase Organization IIL-PORG-1

Carrier ITIL-CR-04

3. Inthe ltems screen area, add calculation sheet T1L.-TCcCS-CN-A183 to the table.

4. Choose |» Set Status » Released
5. Save your freight agreement.

5. Create freight agreement I1IL-FA-CN-A184-01 as follows:

1. Onthe New Freight Agreement screen, enter the type IILA and choose Continue.

2. Onthe General Data tab page, enter the following data:

Field Value
Agreement IIL-FA-CN-A184-01
Description IIL-FA-CN-A184-01
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Field Value

Valid From As required
Valid To As required
Purchase Organization IIL-PORG-1
Carrier [IL-CR-03

3. Inthe ltems screen area, add calculation sheet I1I1L.-TCCS-CN-A183 to the table.

4. Choose |» Set Status » Released
5. Save your entries.
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17 Setting Up Customizing for Freight

Settlements

e Defining Settlement Profiles [page 91]
e Defining Charge Calculation Profiles [page 92]

e Defining General Settings for Charge Calculations [page 93]

171 Defining Settlement Profiles

Context

In this Customizing activity, you define the profile for creating invoices. The settlement profile consists of a set
of parameters with which you can control how the system creates invoices.

Procedure

1. In Customizing for SAP TM, choose

Profile.

2. Create an entry with the following data:

Field

Transportation Management » Settlement » Define Settlement

Value

Settlement Prof

IIL_SP 01

Medium Desc.

<Your description>

Data Source

01 Planned Data

Split/Cons.

FSD_CREAT

Calculation Option

A Copy Fixed Charges and Redetermine Others

Invoicing Level

2 (Settlement on Item)
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Field Value

Collective Settlement Selected

17.2 Defining Charge Calculation Profiles

Procedure

1. In Customizing for SAP TM, choose |[» Transportation Management » Basic Functions » Charge Calculation
Basic Settings » Define Calculation Profile
2. Choose New Entries to create a new entry with the following data:
Field Value
Calculation Profile IIL_CLCPRF
Description IIL: Charge Calculation Profile
Calculation Date Type EET_DATE (Expected End Date of Complete Carriage)
Calculation Level 1 (Calculation on Header Level)
Freight Agreement Determination Rule Blank
Calculation Sheet Determination Rule Blank
Through Rate Deselected
Dimensional Weight Profile Blank
Dimensional Weight Condition Blank
Exchange Rate Type Blank
Data Source Actual Route

3. Save your entries.
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17.3 Defining Charges Profile

Prerequisites

You have defined the organizational units.

Context

You can specify a default assignment of different charge calculation parameters such as the settlement profile,
currency, and exchange rate for the purchasing organization units.

Procedure

1. In Customizing for SAP TM, choose |» Transportation Management » Basic Functions

Basic Settings » Define Charges Profiles
2. Enter the following data:

Charge Calculation

Field Value

Charges Profile IIL CP

Description Charges Profile for IIL
Default Purchase Org. IIL-PORG-1

Settlement Prof. IIL spP 01

Calculation Profile IIL CLCPRF

Purch. Calc. Profile IIL CLCPRF

Local Currency EUR

3. Save your entries.

4. In SAP NetWeaver Business Client, choose [[» Master Data » Organization » Edit Organization and

Staffing

In the Find by screen area, choose Organizational unit and enter IIL-PORG-1 as the object of your search.

6. Onthe Org. Data tab page of your purchase organization, enter your charges profile IIL_CP.
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7. Save your entries.
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18 Integrating ERP Invoices

e Defining Service Masters [page 95]
® Assigning Organizational Units for Purchasing [page 96]
e Defining PPF Settings for ERP Invoicing Integration [page 97]

18.1 Defining Service Masters

Context

You use this procedure to store frequently procured services centrally as master records and use themon a
cross-application basis.

Procedure

1. Onthe SAP Easy Access screen for SAP ERP, choose |» Logistics # Materials Management » Service
Master » Service » Service Master

2. Enter your data using the example provided in the table below for each of the following four service
masters
o Rail freight (internal number range) IIL.-RAIL
o Port Charges Destination (SIT_PORTD) IIL-PORTD
o Port Charges Origin (SIT_PORTO) IIL-PORTO
o QOcean freight (SIT_OCEAN) IIL-OCEAN

i Note

You can identify these service masters either by system-generated numbers or names, but whichever
numbers or names you use will need to be supplied in following procedures.

Field Value
Service Category SERV Service: Purchasing
Base Unit of Measure AU (Activ. Unit)
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Field Value
Mat/Srv. Grp 01 (Material Group 1)
Valuation Class 3200 (Services)

18.2 Assigning Organizational Units for Purchasing

Prerequisites

You have created organizational unit IDs in SAP TM.

Context

In this procedure, you can assign the purchasing business areas from an external transportation management
system to the organizational units in purchasing in the ERP system.

Procedure

1. In Customizing for SAP ERP, choose ||¢ Integration with Other SAP Components j# Transportation
Management » Invoice Integration » Invoicing » Mapping of Organizational Units » Assign Organizational
Units for Purchasing

2. Create an entry with the following data:

i Note

The values given in this table are for illustration purposes only.

Field Value
Logical System <logical system name of your TM system>
TM Pur. Organization Purchasing organization that you created in Creating Or-

ganizational Data in TM [page 55]
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Field Value
Purchasing Org. IIL-PORG-1
Purch. Group 001

Plant 1200
Company Code 1000

18.3 Defining PPF Settings for ERP Invoicing Integration

Context

In this procedure, you configure the settings for the post processing framework (PPF). Since PPF is an output
management framework, it helps you set up output that is specific to your installation. PPF generates output

triggers based on the settings you configure for particular application data records. Based on the configuration
settings, the system processes these triggers to send the actual output.

Procedure

© o N o o p

In Customizing for SAP TM, choose |i¢ Cross-Application Components » Processes and Tools for Enterprise

Applications » Reusable Objects and Functions for BOPF Environment » PPF Adapter for Output
Management » Maintain PPF Settings

. Select entry Appl. /SCMTMS/TRANSPORTATION and choose Condition Configuration (Transportable

Conditions).

In the Scheduling of Actions table, select Transfer Freight Settlement Document to ERP (/ SCMTMS /
TOR_INV_PREP).

Create action definitions /SCMTMS/TOR INV PREP CANCELand /SCMTMS/TOR INV PREP REQUEST.

Select action definition /SCMTMS/TOR INV PREP CANCEL and select the Schedule Condition tab page.

Enter schedule condition /BOFU/EVAL SCHEDULE CONDITION.

Select action definition /SCMTMS/TOR INV PREP REQUEST and choose the Schedule Condition tab page.

Enter schedule condition /BOFU/EVAL SCHEDULE CONDITION.

Choose the Start Condition tab page and enter start condition /BOFU/EVAL START CONDITION.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon # : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
o Links with the icon & : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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